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You must have your Unix account
setup and active by the second class
meeting!

R

Go to the University Bookstore,
second floor, special orders desk, by
the computer books, and purchase The
Primer for $4.95.

R Complete the application form
at the back of The Primer and give it
to your technical consultant at least
three days before the second class
meeting.
R Your technical consultant will
see that your account is set up and
will notify you of your UserID and password in the second class meeting.
R Attend the computer training
sessions scheduled in the syllabus.
Step 2: IR/POSC Lab Permit

R

Complete and return the lab
permit form to your technical consultant in the first class meeting.

R

Your lab permits will be distributed in the second class meeting.

Your technical consultant for IR 499: ICONS Project is Kathy
Matthes. You can contact her in person in VKC 322, by phone
at (213) 740-2130, or by email at matthes@bcf.usc.edu.
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I ntroduction
Welcome to the ICONS Project!
Most of the work you will do for this class will be done on the computer in
the IR/POSC Computer Lab using the Internet. If you are already at home
on the Internet, this class will help you hone your skills. If you are new to
Cyberspace, don’t worry! Computer training is an important part of this
class.
The ICONS Technical Handbook is designed to help you navigate through
the charted (and mostly uncharted) territories of Cyberspace. Yep, you’re
going to be spending a lot of time there communicating with your fellow
U.S. team members and negotiating with the country teams via electronic mail. You’ll
be scrounging around
the Internet for policyrelevant research materials, associating with
subterranean rodents (gophers), playing word games
with comic book characters
such as Veronica and Jughead,
and weaving your way through
the World Wide Web. If that
doesn’t pique your curiosity,
you’ll also be hob-nobbing with Greek deities, Artemis and Apollo, at the
University of Maryland!
WARNING! This handbook is NOT a training manual! You must attend
the hands-on computer training sessions to learn how to use Email, FTP,
Telnet, Gopher, World Wide Web, and the ICONS Polnet II software. Once
you have completed the training sessions, this handbook will take you stepby-step through the various tasks required to do your research, to communicate via email, and to conduct on-line conferences. The rest is up to you!
Cyberspace is waiting . . .

This handbook will remind you how to:
9 Use Host Presenter to Telnet to USC SCF and Artemis.
+ Use Pine to read, send, print, save and forward email.
. Use Wordperfect for Windows 5.2 to create ASCII files.
1 Use WS-FTP to upload and download ASCII files to USC SCF.
7 Use WS-FTP to transfer files to Artemis.
3 Use Notebook to print Polnet email for the ICONS notebook.
. Use Pine to send Polnet messages to all U.S. Team members.
& Use Gopher, Telnet, FTP and WWW to find research data.
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Just the Facts . . .
CYBERSPACE is a word coined by
sci-fi/writer William Gibson in his
novel, Neuromancer, and refers to a
near-future computer network
where users mentally traveled
through matrices of data. It now
means the universe of computers
that one can inhabit as a virtual reality.
ELECTRONIC MAIL (EMAIL) is
similar to regular postal mail, except
it is done electronically.
PROTOCOL is a set of rules for how
computers act when talking to each
other.
FTP (file transfer protocol) is a commonly used protocol for transfering
files from one computer to another.
TELNET is an protocol that allows
you to log into another computer
system and use it as if you were sitting at that computer.
GOPHER is a menu-based system
for tunneling through the Internet.
WWW (World Wide Web) is a
hypertext-based system for finding
and accessing Internet resources
that may include text, graphics,
sound and video.
VERONICA is a service that allows
you to search all Gopher sites for resources by keywords.
JUGHEAD is a program that allows
you to search menu listings on the
USC Gopher.

U nix Account

Just the Facts . . .

Login and Logout
This section is a reminder for how to:
—
—

Use Host Presenter-Telnet to log in to your Unix account.
Logout of Unix and Exit Host Presenter-Telnet.

Reminder 1
Use Host Presenter-Telnet to log in to your Unix account
1. From the Network Information Tools group, double-click on
the Host Presenter-Telnet icon.
2. You will see the “Open Session” window. In the “Host” box
(top) type: girtab (or other SCF host name).
3. Click on the “open” button, or press <Enter>.
4. Login to your Unix account using all lower case letters.
login: type your UserID
password: type your password
5. If your login is successful, you will see the system prompt:
ex: girtab.usc.edu(1):

UNIX: (you-nix) A 32-bit, multiuser, multi-tasking operating system common to networked computing environments and the dominant system used on the Internet.
It's interface is command-based
rather than graphical (icons and
mouse navigation).
HOST PRESENTER/TELNET: A
winsock application program that
enables you to connect from a local computer (the IR/POSC Lab
computers) to a host computer
(your Unix account computer) using the Telnet protocol.
STUDENT COMPUTING FACILITY (SCF): A group of networked
computers, running the Unix operating system, where student accounts are located—aludra, phakt,
castor, alcor, mekab and girtab.
LOGIN: A username for an account on a computer system.

Reminder 2
Logout of Unix and Exit Host Presenter-Telnet
1. To logout of your Unix account, at the Unix prompt, type: logout
(all one word, all lower case letters).
2. To exit Host Presenter-Telnet, at the session window, click on
the “cancel” button. Click on the File menu, and then on “Exit.”
Email Etiquette (or Netiquette)
Electronic mail differs from other means of communication in that it combines the speed and ease of face-to-face or telephone conversation with
the permanence of a letter. It is understandable that problems have arisen
through careless use of this efficient tool. For instance, the lack of nonverbal indicators such as facial expressions, gestures, and tone of voice
used to modify the meaning of what we say can lead to serious misunderstanding. The speed with which we can dash off a reply means that we
sometimes don’t think carefully about what we are saying or how we are
saying it. To avoid misunderstanding, you should read and compose electronic messages with these harzards in mind. Also, absolute privacy cannot be guaranteed in a network environment. Discretion and good judgment are important when you compose email.
Source: Academic Computing at USC, page. 28
2

USERID: The part of your full email
address to the left of the @ sign:
smith@scf.usc.edu
ã
UNIX CASE SENSITIVITY: The
Unix operating system is case sensitive when interpreting commands
and files names. Upper and lower
case letters each mean something
different to Unix. Commands
should be typed in lower case unless otherwise indicated. Be careful never to log in using caps. If
you do, Unix will upcase everything
you type and, therefore, not recognize any of your commands.
LOGOUT: To end a session and
disconnect from a computer or network.

U sing Pine - 1

Just the Facts . . .

Sending Email
This section is a reminder for how to:
— Access the Pine mail program.
— Use Pine to compose, spell check, and send email messages.

Reminder 1

EMAIL (electronic mail) is the term
used both as a name for the messages and for the process of carrying electronic messages from
computer to computer. Email uses
an Internet protocol called TCP/IP.
MAIL PROGRAM: The program
that is used to read, reply to, forward, and save email. Common
Unix mail programs include mail,
elm, cmm and pine.

Access the Pine Mail Program
1. Login to your Unix Account.
2. At the Unix prompt, type: pine.
3. You will see the Pine main menu.

Reminder 2
Use Pine to compose, spell check and send email
1. At the Pine Main Menu, choose the “compose” option.
— Type: C or
— Use the arrow keys to highlight “Compose” and press
<Enter>.
2. Fill in the header:
TO:
Cc:

email address of person(s) sending message to
email address of person(s) you want to receive
a copy of this message
Attchmnt: (leave blank)
Subject:
a one-line description of message topic.
NOTE: if sending to more than one person, separate the email
addresses by a comma.
3. Type in your message.
4. Run the spell checker. Type: ^T.
If the selected word is correctly spelled, press the <Enter>
key to continue. If the selected word is incorrectly spelled,
use the <Backspace> key to erase the word and then type
the correct word.
5. Send the email message.
Type: ^X and confirm with y for “yes.” When the message
is send, you will be returned to the Main Menu.
3

PINE: A Unix email program
whose name stands for pine is not
elm. Pine has a built in full-screen
modeless editor (PICO), MIME
support, and the ability to attach
files.
HEADER: Located at the top of
an email message as rows of information that include who the message is to, who it is from, when it
was sent and what it is about.
EMAIL ADDRESS: An Internet
address, usually in the following
format:
username@host.subdomain.domain.
Ex: smith@aludra.usc.edu.
DOMAIN: The main subdivisions
of Internet addresses, the last part
of an Internet address after the final dot. In the U.S., the standard
domains are:
.com
commerical
.edu
educational
.gov
government
.mil
military
.org
non-profit org.
.net
network
Outside the U.S., the top-level domain is usually the country domain,
such as .ca for Canada, .de for Germany, and .uk for the United Kingdom.
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Just the Facts . . .

Reading Email
This section is a reminder for how to:
—
—
—
—

Read and reply to an email message.
Print an email message.
Forward an email message.
Save an email message.

]

Reminder 1
Read and Reply to Email Messages
1. At the Pine Main Menu, choose the “Folder Index” option.
— Type: I or
— Use arrow keys to highlight “Folder Index”and press
<Enter>.
2. Choose email message to read:
• Use arrow keys to highlight message.
• Type: V (to view message).
• Read the message. Use the <Space> bar to see the next
page, if required.
•
•
•
•
•
•
•
•

Type: R (to reply to the message).
Pine will ask if you want to include the original message
in your reply. Type: y.
Pine will automatically put the return address in the TO:
part of the header.
Pine will put the cursor in the Message section of the
message, with the original message below it.
Type in the person’s first name and a comma.
Use the arrow keys to move down below the message
and reply to it.
Run the spell checker if desired (^T).
Send the message (^X).

Network Ethics
Email and network users at USC should be aware that there is a code of
ethics for users of networked computers to protect the rights and intellectual property of other users and to maintain the integrity of the connected
systems. Computer and network misconduct is a serious violation of academic values and some acts of misconduct are subject to criminal and
civil law. All USC computer users are expected to respect the rights and
property of others, and willful misconduct will be prosecuted by law and
by the Office of Student Conduct at USC.
4

NOTE: If you have not configured
Pine to print to your local computer,
do the following:
—

From the Main Menu, type: S
(for Setup).

—

Type: P (for printer setup).

—

Type: 1 (for printer attached
to your local computer).

You will not have to repeat this procedure each time you use Pine.
FOLDER INDEX: Displays a summary caption for each message in
the open folder. The message that
is highlighted is the “Current” message. Commands available from
this screen (e.g. View, Reply, Forward, Delete, Print, and Save) apply to the current message.
STATUS: The markings on the left
side of the message tell you what
its status is. You may see one or
more of the following codes on any
message:
"D" for Deleted. You have marked
this message for deletion but have
not yet eXpunged it.
"N" for New. You have not looked
at the text of the message yet.
"A" for Answered. When you reply to a message it is considered
to be answered.
"+" for direct-to-you. The "+" indicates that a message was sent
directly to your account, your copy
is not part of a cc: or a mailing list.
"*" for Important. You have previously used the "Flag" command to
mark this message as "important".

Just the Facts . . .

Reminder 2
Print an Email Message
1. To print a message:
•
•
•
•

Use the arrow keys to highlight the message.
Type: O (for Other Commands) to find the command for
printing.
Type: Y (to print message) and type: y to confirm.
Type: O (for Other Commands) twice to return to main
selections.

Reminder 3
Forward an Email Message
1. To forward a message.
•
•
•
•
•
•
•
•

Look at the command list at the bottom of the screen to find
the command to forward the message.
Type: F (to forward).
In the TO: part of the header, type the email address of the
person to whom you want to forward the message.
Use the arrow keys to move to the Message section.
Type the person’s name and a comma.
Explain why you are forwarding this message.
Spell check (^T) if required.
Send the message (^X).

Reminder 4
Save an Email Message
1. To save a message:
•
•
•
•
•
•
•

Use the arrow keys to highlight the message.
Type: O (for Other Commands) to find the command to
save a message.
Type: S (to save the message).
Type: <Enter> to put the message in your “saved-messages”
folder, or create a new folder by typing in the name of the
new folder.
The saved message will be copied to the appropriate folder
and then marked for deletion in your INBOX folder.
Type: O (for Other Commands) twice to return to main
selections.
Type: M (to return to the Main Menu).
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REPLY AND FORWARD: Replying
(R) and Forwarding (F) are two alternatives for answering your email
messages. Use “reply” if you want
to send email back to the author of
the message and/or the other
people who have already seen it.
Use “forward” if you want to send
the message to someone who has
not yet seen it.
SAVE: One of two alternatives for
keeping a copy of your messages.
Your messages are automatically
saved in your INBOX until you expunge them. However, you may
want to save messages to other folders to keep the number of messages
in your INBOX down to a minimum.
Use the SAVE command to move
messages to the “saved-messages”
folder, or create a new folder.
EXPUNGE: Removes all messages
marked for deletion. Messages
marked with a “D” are not deleted
from your folder until you expunge
them. Once expunged, they are
permanently gone.
CONTROL KEY: Many commands
in Pine use a combination of the
Control Key and a letter. A caret
(^) indicates the use of the Control
Key.
DON'T USE THE <ENTER> KEY:
Most of Pine's commands are given
with a letter or the Control Key and
a letter. Do not hit the <Enter> key
after typing these commands.
REPAINTING THE SCREEN: If you
experience line noise and your
screen is not displayed correctly,
use the Ctrl-L command to repaint
your screen.

U sing Pine - 3
Managing Your Mailbox
This section is a reminder for how to:
— Select a folder.
— Delete, print or save messages in selected folder.

Reminder 1
Select a Folder
1.

From the Main Menu, type: L
or highlight “Folder List” and press <Enter>. You will see:

Folder-collection <home/scf-02/username/mail/[]> **Default for Saves*

Just the Facts . . .
FOLDER LIST: Displays your message folders and allow you to open
(view) a new one, or manage your
folders using the Rename, Delete,
and Add commands. The status bar
shows information about the current folder.
FOLDERS: Files where messages
are kept. Every message has to be
in a folder. Initially, you have three
folders: INBOX (for incoming
email), Sent-mail (for all outgoing
email) and Saved-messages (for
messages you have moved from
your INBOX).

[Select Here to See Expanded List]
News-collection <Subscribed-Groups> ...
[Select Here to See Expanded List]

2.

The first [Select . . .] should be highlighted. Press <Enter>.
• You will see the names of folders (default folders are Inbox,
sent-mail, and saved-messages).
• Use the arrow keys to highlight the folder to manage.
• Type: V (to view folder).

CREATING FOLDERS: You may
create new folders in which to save
your messages. They must be
given names that can be filenames
on the Unix system.
MOVING BETWEEN FOLDERS:
You can move messages from one
folder to another by opening the
original folder and saving messages
into the other folder just as you
would save messages from your
INBOX to any other folder.

OTHER COMMANDS:

Reminder 2
Delete, print or save messages in selected folder.
1.

A = Add a folder
You may print, save or delete messages using these commands:
• To delete messages, highlight each message to be deleted
and type: D for delete.
• When done marking, type: X (to expunge the messages).

G = Specify a folder to go to
I = Show FOLDER INDEX of
current folder

• To print messages, highlight each message to be printed and
type: Y to print and y to confirm.

W = Whereis (search folder
names)

• To save messages, highlight each message to be saved and
type: S to save. Type: Y if you want to save it to the “savedmessages” folder, or type in a new folder name to create a
new folder.

Y Print folder listing

6
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Just the Facts . . .

Email Address Book
This section is a reminder for how to:
—
—
—
—

List individuals in your address book.
Create a distribution list (mailing list).
Manage your address book.
Use the address book or aliases to address email messages.

Reminder 1
List Individuals in Your Address Book
1. At the Pine Main Menu, choose the “Address Book” option.
— Type: A or
— Use arrow keys to highlight “Address Book”and press
<Enter>.
2. To add individuals to your Address Book, type: A (for Add).
You will be prompted to fill in the following information:
New full name (Last, First):
Enter new nickname (one word and easy to remember):
Enter new email address:
Do this for each person you want to record in the Address Book.
PINE 3.91

ADDRESS BOOK

Folder: INBOX 3 Messages

Kathy
SimCom

Matthes, Kathy
Kaufman, Joyce

matthes@bcf.usc.edu
kaufmanj@cerfnet.com

? Help M Main Menu
P PrevEntry - PrevPageD Delete S CreateList
O Other Cmds E [Edit]] N NextEntry Spc NextPage A Add Z AddToList

Reminder 2
Create a Distribution List
2. To create a distribution list, type: S (CreateList). You will be
prompted to fill in the following information:
— Long name/descriptions of new list: ICONS
— Enter list nickname (one word): ICONS
— Enter 1st address (enter the full email address for each U.S.
team member).
— Press <Enter> instead of typing another email address when
done.
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ADDRESS BOOK: A feature in
the Pine mailer where email address can be listed for individuals
(as in a phone book) and for distribution lists (an electronic mailing list).
REQUIRED FIELDS: Three required fields for individual entries
are:
NICKNAME: A one-word label to
identify the person.
FULLNAME: The full name of the
person or organization, which are
entered last name first so they sort
in alphabetical order.
ADDRESS: The actual email address itself. This must be a valid
Internet address that conforms to
the Internet DNS standard.
OPTIONAL FIELDS:
FCC (Folder Carbon Copy): You
can save a copy of any outgoing
message to this address in a folder
name entered in this section.
COMMENTS: This field contains
arbitrary text for your convenience.
Due to screen width limitations,
these last two fields do not show
up in the normal ADDRESS BOOK
display. You must select the "Edit"
command to view or modify them.
DISTRIBUTION LIST: A simple
form of mailing list in which an
alias is assigned to list of email addresses. Mail directed to the alias
is sent to every address on the list.

PINE 3.91
ICONS

? Help

ADDRESS BOOK
ICONS

M Main Menu

O Other Cmds

DISTRIBUTION LIST:
jcleary@scf.usc.edu
jeffwlee@scf.usc.edu
jmalone@scf.usc.edu

P PrevEntry

E [Edit]]

Folder: INBOX

- PrevPage

N NextEntry

D Delete

Spc NextPage

S CreateList

A Add

Z AddToList

Just the Facts . . .
PINE DISTRIBUTION LISTS:
Each list has a nickname, a full
name and a list of addresses. Addresses may be normal email addresses or they may even refer to
other distribution lists.
ALIAS: An abbreviation for an
email address stored in a mail program (such as Pine), allowing the
user to type or select the shorter
alias name instead of the full email
address when addressing email.

Reminder 3
Manage Your Address Book
1. To edit your address book:
— Use the arrow keys to highlight the individual or distribution list entry to be edited.
— Type: E (for edit).
— At the bottom of the screen you will see a list of fields to
edit. Type the corresponding letter.
— Use the <backspace> key to delete incorrect information and type in the correct information.
— Do this for each field you want to edit.
2. To print your address book list:
— Type O (for Other Commands) to find the command for
printing.
— Type Y to print and y to confirm.
3. To delete entries from your address book list:
— Use the arrow keys to highlight the entry you want to
delete.
— Type D to delete and y to confirm.

Reminder 4
Use Address Book or Aliases to Address Email Messages
1. At the Pine Main Menu, choose the “Address Book” option.
—
Type: A or
—
Use arrow keys to highlight “Address Book”and press
<Enter>.
2. Using the arrow keys, highlight the name of person (or the distribution list) to whom you want to send email.
8

NICKNAME: An alias or address
book entry in some email programs, such as Pine.
OTHER COMMANDS:
E
A
D
Y

Edit selected entry
Add a single entry
Delete selected entry
Print address book

DELETE (D) will delete a single
address from the list if the cursor
is placed on the address; it will
delete the entire distribution list if
the cursor is on the nickname
fullname line.
FCC and COMMENTS: Each entry in the address book also has
two optional fields, fcc and comments. To look at or edit either of
these, use the Edit command (E).
The comments field is just for your
own use. The fcc field overrides
the default fcc if this address is the
first one on the To line.
WHEREIS: This command may be
used to search for particular strings
in the address book, including the
comment and fcc fields.

Just the Facts . . .

•

Type: C (to compose a message).

•

Pine will automatically open a new message and insert the
email address in the TO: part of the header.
OR

•

From the Main Menu, type: C, or highlight “Compose,” to
open a new message.

•

In the TO: part of the header, type the alias name (nickname)
of the person (or distribution list) to whom you want to send
email.

Note: When using the alias name (nickname), the person (or
distribution list) must be listed in your address book.
3. Complete the message and sent it (^X).

USC UNIVERSITY COMPUTING SERVICES
Account Usage Policies
User Account Access
Users should not give access to their account in any way to any other person. This means users should not give their password to a friend, allow
remote, passwordless logins to their account, or log someone in and then
let them use the account. This applies equally to all UCS supported machines connected to the main campus network.
If UCS determines that access to an account has been compromised, the
account may be disabled for security reasons.
Users are responsible for all actions performed by their account. If a user
has any knowledge of use by another party, not only is he/she in violation
of this policy, but he/she is responsible for any actions taken by the unauthorized user.
9

PINE HELP: Pine help is contextsensitive--each screen you use will
have its own help text, explaining
the choices available for that
screen.
Choosing Help from the Main
Menu (?) will not only describe the
specific commands available from
the Main Menu, but also provide
an overview of Pine operation.
SETUP COMMAND: Unless it has
been administratively disabled, you
can set or unset various features.
The SETUP COMMAND (available
only from the MAIN MENU)
prompts you for one of several
configuration screens, including
the SETUP CONFIGURATION
screen, by which you may activate
optional Pine features.
CONFIG HELP: When you choose
the CONFIG option, you will see a
list of features that you can modify.
BEFORE you change any feature,
use the context-sensitive help system. Hightlight the desired feature
and then press “?”. The purpose
of the feature will be explained as
well as the various options and
their outcomes. Follow the directions to change that feature.
TAKE ADDRESS: Extracts an
email address from an incoming
message and saves it in the Pine
address book. If the message is
addressed only to you, then you
only need to provide a nickname.
If the message has more than one
recipient or an email list involved,
then an address selection screen
will allow you choose the address
you want to save, or add several
of them to a personal address list.

F ile Transfer - 1
Uploading Files for Email
This section is a reminder for how to:
— Use Wordperfect to create an ASCII text file.
—
—

Use WS-FTP to upload an ASCII file to your Unix account.
Use Pine to insert the ASCII file into an email message.

<

You will need a 3.5" floppy disk

Reminder 1
Use Wordperfect to create an ASCII text file
1. In the Wordperfect group, double-click on the WPwin icon.
2. Type your message. Do not add formatting commands (i.e.,
fonts, underlining, bold face, etc.).
3. Make sure your floppy disk is in Drive A. Click on the File menu
and choose Save.
4. Set the configurations for ASCII text and floppy Drive A.
Destination drive = a:
File type = ASCII Text (or DOS Text)
Name = name file in DOS file name format.
5. Click on the OK button.
6. Click on the File menu and choose Exit to quit Wordperfect.

Reminder 2
Use WS-FTP to upload an ASCII file to your Unix account
1. In the Network Information Tools group, double-click on the
WS-FTP icon.
2. You will see the “Session Profile” window. Click on the “new”
button.
3. Fill in the following information:
(NOTE! Do not use the <Enter> key to move between the
boxes; use the <Tab> key or click in each box.)
10

Just the Facts . . .
ASCII (American Standard Code
for Information Exchange), pronounced as-kee, is a numeric encoding of text characters. For your
purposes, think of it as generic text
without formatting. When you
save a file in Wordperfect for instance, program codes are embedded in the file that make it uniquely
a Wordperfect file. Saving a file as
an ASCII text file strips away all the
program coding and leaves plain
text.
ASCII files are important because
many programs cannot read other
program’s files, but almost all programs can read an ASCII file. For
example, you cannot insert a
Wordperfect file into a Pine email
message--Pine does not know how
to read Wordperfect codes. You
will see garbled characters on the
screen instead of your message.
If you want to type a message on a
wordprocessor and then later send
it as an email message, always convert the file to ASCII text before
uploading it and inserting it into
your email message.
DOS FILE NAMES must not exceed 11 characters (8 characters
with an optional dot extension of
three characters). Names cannot
contain spaces or any of the following characters: * ? / \ | . , : ; +
={}[]&^<>
You can add a three-character file
extension to file name by adding a
period ( . ) and three more characters (e.g., NAFTA.txt).
UPLOAD: Transfer a file from a local computer (e.g., IR/POSC Lab
computer) to a host computer (e.g.,
SCF Unix computer).

Host name:
Host type:
UserID:
Password:

girtab.usc.edu (or other SCF host name)
(leave on auto)
Your Unix account UserID
Your Unix account password

4. Click on the “save” button.
5. Click on the “Profile Name” arrow. Click on girtab.usc.edu (or
the SCF host name you entered above). Click on the “OK”
button to the right.
6. You will see the transfer screen with two windows: local system
(left) and remote (right). You should see connection information in the lower left corner of the screen.
7. Click on the radio button marked “ASCII” below the “local system” window.
8. Double-click on the a: to change the drive on the “local” system
to the A drive. You will see a list of files located on the floppy
disk in the “local” window if the disk contains files. You should
see files located on your Unix account directory in the “remote”
window.
9. Click on the file name in the “local” window that you want to
transfer to your Unix account directory (to highlight more than
one file name, hold down the <Shift> key and click on each file
name).
10. Click on the arrow pointing to the right, located in between the
“local” and “remote” system windows. You should see the file
transfer window as the file transfers.

Just the Facts . . .
WS-FTP SCREEN DESCRIPTION:
The left half of the main window is
the local information. The right half
of the main window is the remote
information. Each side of the main
window has two boxes of lists. The
upper box is a list of directories and
the lower half is a list of files. Just
to the right of the two file list boxes
are a column of buttons.
SETTING UP A PROFILE
PROFILE NAME: The name used
to identify the connection you are
creating.
REMOTE HOST NAME: This is either a fully qualified Internet host
name (such as aludra@scf.usc.edu)
or an IP address (such as
128.125.253.134).
REMOTE HOST TYPE: If you know
the host type, select it from the
drop down list. If not, use “auto
detect.”
USERID: Enter the userid that you
wish to use for this profile.

11. When the transfer is complete, click on the “refresh” button on
the “remote” system window to verify that the file was transferred.

PASSWORD: Enter the password
you wish to use for the userid that
you entered for this profile.

12. Close the FTP connection to Unix by clicking on the “close”
button (far left, bottom of screen). Exit WS-FTP by clicking on
the “exit” button (far right, bottom of screen).

ACCOUNT: If the remote host requires an account name, enter it
here.

Reminder 3
Use Pine to insert the ASCII file into an email message
1. In the Network Information Tools group, double-click on the
“Host Presenter-Telnet” icon to Telnet to your Unix account.
2. You will see an “Open Session” window. In the “Host” box (top),
type: girtab.usc.edu (or other SCF host name).
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ANONYMOUS: If you do not have
an account on the profile host computer, you will need to do an
“anonymous FTP.” Normally, the
userid is the word “anonymous” and
the password is your full email address. Most FTP sites support
anonymous logins.

Just the Facts . . .

3. Login to your Unix account.
4. At the Unix prompt, type: pine.
5. At the Pine Main Menu, Press “C” to compose a message.
6. Fill in the header portion of the message.
7. Move the cursor down to the text area of the message.
8. To insert your uploaded file into the email message, type: ^R
(control key + R). To see a list of available files, type: ^T (control + T).
9. Highlight the file name to insert and type: s (select). You will
see the selected file scroll across the screen in the email message.
10. When the file is inserted into the email message, complete any
editing or additional typing and send the file (^X).
11. To end your Pine session, type: q.
12. Logout of your Unix account (at the Unix prompt, type: logout).
13. To close your Host Presenter session, click on the “close” button. Click on the File Menu and the Exit.

Hacking
While UCS encourages the use of computing resources for personal development and exploration, it does not condone the practice of “hacking”
where users attempt to compromise computer security.
Engaging in any activities designed to intentionally compromise computer security at any site, be it USC or elsewhere, will not be tolerated,
and any evidence of such activity will result in corrective action by UCS.
The actions taken by UCS in these matters include, but are not limited to,
the disabling or termination of computer accounts of all involved parties,
a report to the USC Student Conduct office for appropriate academic action, and/or civil or criminal charges.
Sending harassing or offensive electronic mail and/or sending forged electronic mail is a violation of UCS computing policies and will be subject to
corrective action.
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READ FILE (^R): This command
allows you to import text from an
existing file into an email message. You will be prompted for
the name of a file to be inserted
into the message. The file will be
inserted where the cursor is located in the email message.
TO FILES (^T): Use this command to browse the list of files in
your Unix account to find the file
you want to import into your
email message. The file can be
one you have either created with
a Unix text editor (such as Pico
or Emacs) or one you have uploaded to your Unix account. The
file must be located in your Unix
account directory for Pine to insert it into an email message.
NOTE: If you know the name of
the file you want to insert, you
do not need to type ^T to list the
file names. After you type ^R,
simply type in the file name you
want to insert.
JUSTIFY (^J): This command reformats the text in the paragraph
the cursor is in. Paragraphs are
separated by one blank line. This
is useful when you have been editing a paragraph and the lines
become uneven.
MARK, CUT, AND PASTE: You
can define a block of text, which
can be deleted or copied as a unit,
by setting a mark at the start of
the block (Ctrl-^) and then moving the cursor to the end of the
text block. You can then “cut” the
block out (^K), move the cursor,
and “paste” it (^U) in the new location.

F ile Transfer - 2
Downloading Files From Email
This section is a reminder for how to:
—
—
—

Export the file from Pine to your Unix account.
Use WS-FTP to download the file to your floppy disk.
Use Wordperfect to print the file.

<

You will need a 3.5" floppy disk.

Just the Facts . . .
EXPORT: Move a file out of one
program and into another. Since
you are not able to download a file
directly from Pine, you need to
export it to your Unix directory.
The original message still resides
in your Pine mailbox; the message
is converted to an ASCII file and
exported to your Unix directory.

Reminder 1
Export the file from Pine to your Unix account
1. Login to your Unix account. At the Unix system prompt, type:
pine.
2. Type: I (for folder index) or highlight I and press <Enter>.
3. Highlight the message you want to export. (Type: V to view the
message if necessary).
4. Type: E (to export the email message to your Unix directory).
You will be asked to give the message a name. Use DOS rules.
5. Type: Q to exit pine.
8. At the Unix prompt, type: logout (to logout of your account).
9. Click the “Cancel” button in the Host Presenter-Telnet window.
10. Click on the File menu and then choose Exit.

Reminder 2
Use WS-FTP to download the file to your floppy disk
1. In the Lan Workplace group, double-click on the WS-FTP icon.
2. In the “Session Profile” window, click on the “new” button.
3. Fill in the following information:
Host name:
Host type:
UserID:
Password:

girtab.usc.edu (or aludra or phakt)
(leave on auto)
Your Unix account UserID
Your Unix account password
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DOS FILE NAMES must not exceed 11 characters (8 characters
with an optional dot extension of
three characters). Names cannot
contain spaces or any of the following characters: * ? / \ | . , : ; +
={}[]&^<>
You can add a three-character file
extension to file name by adding a
period ( . ) and three more characters (e.g., NAFTA.txt).

Just the Facts . . .

4. Click on the “save” button.
5. Click on the “Profile Name” arrow. Click on girtab.usc.edu (or
whatever SCF host name you entered above).
6. Click on the “OK” button to the right.
7. You will see the transfer screen with two windows: local system
(left) and remote (right).
8. Click on the radio button “ASCII” below the “local system” window.
9. Change the drive on the “local” system to A.
10. In the “remote” window, you should see files located on your
Unix account directory.

NOTE: To transfer more than
one file, highlight the first file
name, scroll down to the last file
name in a consecutive series, hold
the <Shift> key and click on the
last file name that you want to
transfer. If file names are not successively listed, you must select
and transfer each file separately.

11. Click on the file name in the “remote” window that you have
exported and want to transfer to your Unix directory.
12. Click on the arrow pointing to the left, located in between the
“local” and “remote” system windows. You should see the file
transfer window as the file transfers.
13. Close the FTP connection to Unix by clicking on the “close”
button (far left, bottom of screen). Exit WS-FTP by clicking on
the “exit” button (far right, bottom of screen).

Reminder 3

NOTE: You can also do a quick
print of the file while you are still
in WS-FTP.
1. In the Local window, click on
the file name you want to print.

Use Wordperfect to print the file
1. In the Wordperfect group, double-click on the WPwin icon.
2. Make sure your floppy disk is in Drive A. Click on the File
menu and choose Open.
3. Choose the A: drive. Click on the file name. You will be asked
if the ASCII file format is okay; click on the “YES” button.
4. Do any editing or formatting you desire.
5. Click on the File menu and choose Print.
6. Click on the Print button at bottom of print menu screen.
7. When done sending job to the printer, click on the File menu and
choose Close (file).
8. Click on the File menu and choose Exit to quit Wordperfect.
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2. Click on the View button to
the right. You will see the text
on the screen via the Windows
Notepad program (and ASCII text
editor).
3. Click on the File Menu and
choose Print.
4. After the file has spooled to
the printer, click on the File Menu
and choose Exit to quit the
Notepad program.
5. Do this for each file you want
to print from WS-FTP.

I nternet Protocols

Just the Facts . . .

Telnet
This section is a reminder for how to:
—

Use Host Presenter-Telnet to connect to Telnet sites.

Reminder 1
Use Host Presenter-Telnet to connect to Telnet sites
1. When you locate a telnet site, gather the following information:
Telnet address, login name and password.
2. In the Network Information Tools group, double-click on the
Host Presenter-Telnet icon.
3. You will see the “Open Session” window. In the “Host” box
(top) type the Telnet address.
NOTE: If the Internet address is listed in URL format, the telnet
address it is located after the “telnet://” and before any forward
slashes (/) indicating directories. For example:
URL = telnet://info.umd.edu/Education resources/Economic data
The telnet address is: info.umd.edu

URL addresses are used with World Wide Web browsers such
as Netscape. Host Presenter-Telnet cannot use URLs.
4. If required, login to the system using the login name and password indicated either in the Telnet address source listing or on
the system’s initial screen.
5. Follow the system’s menus to locate your desired information.
6. If possible, email the information to yourself.
7. When you are done, logout of the system (usually quit or exit–or
type ^] if you can’t find your way to the quit menu).
8. To quit Host Presenter-Telnet, click on the “Cancel” button. Click
on the File menu and choose Exit.
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TELNET is a tool that allows you
to connect to and use another computer on the Internet.
LOGIN AND PASSWORDS are often required at Telnet sites and are
generally words like “guest.” Check
the source of your address information for login and password
names.
VT100 is the terminal type you enter if requested before, during or
after login.
PORT NUMBERS are sometimes
included in the Telnet address and
it is important that you include it
as part of the address when you
type in the host name in Host Presenter. A Telnet address with a port
number would look like this:
artemis.umd.edu 7001
IP NUMBERS are not always listed,
but every Telnet address has one.
Either the IP number or the IP address can be used as the host
name. For example: the IP number for the Environet telnet site is
128.183.104.16; the IP address is:
envnet.gsfc.nasa.gov.
WHEN ALL ELSE FAILS . . . ^]
(control key, right bracket key) is
your security blanket during Telnet
sessions. If you get stuck, ^] will
usually disconnect you.
COMMAND LINE TELNET: You
can also access Telnet directly from
your Unix account if you don't have
access to Host Presenter. At your
Unix prompt, type:
telnet IP address
When you are done with your
Telnet session, at the Telnet
prompt, type: quit.

I nternet Protocols
File Transfer Protocol (FTP)
This section is a reminder for how to:
—
—
—

Locate FTP address information.
Use WS-FTP to connect to FTP sites.
Browse directories and ftp files to your local computer.

Reminder 1
Locate FTP site listings and FTP address information
1. When you locate a site, gather the following information:
—
—
—
—

FTP address: (ex: ecix.doc.gov or ftp.stat-usa.gov)
Login name: (usually “anonymous”)
Password: (usually your email address)
The subdirectories where the information is located.

NOTE: If the address is listed in URL format, it is located after
the telnet:// and before any forward slashes (/) indicating directories. For example:
URL = ftp://library.ncsu.edu/pub/ncsu/senate
The ftp address is: library.ncsu.edu

Reminder 2
Use WS-FTP to connect to FTP sites
1. In the Network Information Tools group, double-click on the
WS-FTP icon. You will see the “Session Profile” window. Click
on the “new” button.
2. Fill in the following information:
(NOTE! Do not use the <Enter> key to move between the
boxes; use the <Tab> key or click in each box.)
Host name:
Host type:
UserID:
Password:

the FTP address
(leave on auto)
anonymous
your full email address

NOTE: If the FTP address has a port number, before you save the
entry you must click on the “Advanced” button and fill in the port
number. Click on the OK button; you will be returned to the first
screen.
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Just the Facts . . .
ANONYMOUS FTP is the most
usual method of providing information to the public. Unless the ftp
site listing indicates a specific login
name and password (and this does
occur), you can assume that it is an
anonymous ftp site.
The LOGIN NAME is the actual
word “anonymous” and the PASSWORD is usually your full email
address. For example:
VT100 is the terminal type you enter if requested before, during or
after login.
FTP ADDRESSES may or may not
include the letters “ftp” in the address. When this occurs, the address will have the letters “ftp” followed by a dot and the address.
For example, if the address was
ftp.stat-usa.gov, you would type:
ftp.stat-usa.gov as the host name in
WS-FTP.
PORT NUMBERS are sometimes
included in the FTP address and it
is important that you use it. An FTP
address with a port number would
look like this:
artemis.umd.edu 7001
IP NUMBERS are not generally
listed, but every FTP address has
one. Either the IP number or the
English equivalent IR address can
be used as the host name. The IP
number for ftp.fedworld.gov is
192.239.92.205.
WHEN ALL ELSE FAILS . . . ^]
(control key, right bracket key) is
your security blanket during FTP
sessions. If you get stuck, ^] will
usually disconnect you.

Just the Facts . . .

4. Click on the “save” button.
5. Click on the “Profile Name” arrow. Click on the name of the
entry you just created. Click on the “OK” button to the right.
6. You will see the transfer screen with two windows: local system
(left) and remote (right). You should see connection information in the lower left corner of the screen.

DIRECTORIES are ways to categorize information. All FTP sites have
files arranged in directories and
subdirectories. You must navigate
through the directories to find the
files you want to transfer.

7. Double-click on the a: to change the drive on the “local” system
to the A drive, so your ftp’d files are transferred to the floppy
disk. You should see directories listed in the top half and files
listed in the bottom section of the “local” window, if present on
the floppy disk.

NETIQUETTE is the Internet word
for net etiquette and refers to rules
of general good behavior when
using the Internet. Some points to
remember are:

Reminder 3
Browse directories and FTP files to your local computer

— Keep connection times short,

1. If the connection is successful, you should see directories listed
in the top half and files listed in the bottom section of the “remote” system window.
2. If your FTP listing provided directory information, double-click
on the directory words until you find the correct directory. Otherwise, browse the directories for the information you want.
3. Look at the list of files in the directories. To view text files, click
on the file name and then click on the “view” button to the left.
When you are done viewing the text, click on the File menu and
then choose Exit.
(NOTE: Some text files may be too big for viewing.)
4. When you know which file you want to transfer, click on the file
name (or highlight several files names to transfer at one time).
5. Determine if the file is ASCII text or a program file and set the
radio buttons correctly. (Do not mix types if sending more than
one file.)
6. Click on the arrow pointing left in between the local and remote
windows to transfer the files. You should see the file transfer
window as the file transfers.
7. Repeat numbers 2-6 above for all the files you want to transfer.
8. Close the FTP connection by clicking on the “close” button (far
left, bottom of screen). Exit WS-FTP by clicking on the “exit”
button (far right, bottom of screen).
9. Use a wordprocessor to print out the files.
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since most anonymous FTP archives are provided by the goodwill of the host institution and are
usually housed on computers used
for real work. FTP archives can be
discontinued if too many people
spend too much time on the system.

— Use the search tool Archie to
locate information so you don’t
spend a lot of time browsing.

— If you must browse, download
the index file, disconnect from the
FTP site and reconnect later when
you have found your information
in the index.

— Download after hours (remember time zone changes).
REMEMBER RADIO BUTTONS!
ASCII text files are plain text files
and you must set the radio button
to ASCII in WS-FTP to transfer
them.
Binary files are program files. If
you are transferring program files,
you must set the radio button to
“binary.”

I nternet Protocols
Gopher & Search Tools
This section is a reminder for how to:
—
—
—

Use WS-Gopher to access the School of IR’s
IR-Related Internet Resource Directory.
Use Jughead to search the USCGopher menus.
Use Veronica to search for topics in Gopher space.

Reminder 1
Use WS-Gopher to Access the IR-Related Internet Directory
1. In the Network Information Tools group, double-click on the
WS-Gopher icon.
— To navigate, double-click on a menu item. To go back a level,
click on the 7th button in from the left. To go back to the
USCGopher home page, click on the house icon.
— To print a document, display the document on the screen and
click on the printer icon, or click on the File menu and choose
Print.
— To save a document to disk, click on the floppy disk icon, or
click on the File menu and choose Save Item. Select the A
drive, name the file and click on the OK button.
— To go to a Gopher location using the Internet address, click
on the File menu and choose “New Gopher Item.” You only
need to fill in the URL at the bottom of the window.
2. To access the IR-Related Internet Resource Directory, doubleclick on the following menus:
University Information
Academic Departments
School of Intenational Relations
IR-Related Internet Resources
School of IR Internet Resource Directory
3. Read “How to use this directory.” Browse the directory for IR
resources.
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Just the Facts . . .
GOPHER: A client/server application that makes navigating and accessing Internet resources as easy
as choosing an item from a menu
list. Gopher clients can display
text documents on screen, save
them to a file and/or print them.
Some Gopher clients allow you to
email the document to yourself.
Gopher also allows you to perform
FTP transfers and remote (telnet)
logins as well as searches with indexing programs such as Jughead
and Veronica.
GOPHER SERVER: An application that provides documents and
menus to Gopher clients.
GOPHER CLIENT: The Gopher
program that retrieves the menus
and documents from the Gopher
servers and displays them for you.
GOPHER SPACE: A conceptual
space encompassing all of the
menus and documents that can be
reached via the interconnected
system of Gopher servers on the
Internet.
VERONICA: A service that allows
you to search all Gopher sites for
resources by keywords.
JUGHEAD is a program that allows you to search menu listings
on the USC Gopher.

Just the Facts . . .

Reminder 2
Use Jughead to Search the USC Gopher Menus
1. In the Network Information Tools group, double-click on the
WS-Gopher icon.
2. Double-click on the following menus:
How to Find Things on the Gopher
Search USCgopher by Menu Title (Jughead search)
3. You will see:
Search for document containing one or more of the following.
Type keywords for your search in the box and click on the search
button. For example, type: international relations. You will get
a list of all menu items on the USC Gopher that use those words.
4. Navigate throught the menus to locate the information as usual.
Repeat numbers 2-3 above if more searches are necessary.

Reminder 3
Use Veronica to Search for Topics in Gopher Space
1. In the Network Information Tools group, double-click on the
WS-Gopher icon.
2. Double-click on the following menus:
How to Find Things on the Gopher
Search ALL gophers by keyword (Veronica search)
How to Compose veronica Queries
3. Read the directions. Back up a menu.
4. Choose one of the Veronica servers at the bottom of the menu.
5. You will see:
Search for document containing one or more of the following.
Type keywords for your search in the box and click on the search
button. Veronica will build you a menu list of sites.
6. Navigate through the menus to locate the information as usual.
Repeat numbers 4-6 above if more searches are necessary.
NOTE: Veronica servers are often overtaxed by users and you
many get a “busy” signal. Choose another server site on the
Veronica list and try again. If all else fails, try at a less congested
time.
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JUGHEAD SEARCH: This allows
you search by keyword through all
of the menus located on the USC
Gopher server. It will produce a
menu list with all items that match
your keyword query.
VERONICA: A utility program that
indexes the titles of all levels of
menus for the majority of Gopher
sites on the Internet. You enter a
word or group of words and
Veronica creates a custom menu
of all titles of all menus throughout Gopherspace that match your
query.
Like most programs, Veronica has
some drawbacks. There are a limited number of servers offering this
service and they are used extensively. Therefore, you often get a
"busy" signal and have to try later.
Because you are using a index
search, you may get many repeated
items in your custom menu list.
Since many people use the service,
it is often slow. However, it is a
valuable resource when available.

I nternet Protocols

Just the Facts . . .

World Wide Web
This section is a reminder for how to:
—
—
—
—

Use Netscape to navigate the USCWeb.
Use URLs to connect to Web sites.
Use Net Search to do a subject search.
Use Netscape for FTP, Telnet and Gopher.

Reminder 1
Use Netscape to Navigate the USCWeb
1. In the Network Information Tools group, double-click on the
Netscape icon.
2. You will see the USC Home Page and the following categories:
—
—
—
—
—

USC Information
Academic Resources
USC Showcase
People at USC
New, Help and Index buttons at bottom

To access the Netscape handbook and on-line tutorial, click on
the Help menu (at the top right of the Netscape screen).
3. To use Netscape:
— Click on text or graphic links or buttons.
(You can tell what is “hot” by moving the mouse over the
graphics; if the arrow changes to a hand, it’s a link. Text links
are usually in blue lettering and underlined.)
— To backup to a previous page, click on the Back button.
— To go to the USC Home Page, click on the Home button.
— To print a Web page, click on the Print button.
— To save a Web page to a file, click on the File menu and choose
“Save As.” Select your directory and/or drive. If you want
to save the text (without the HTML codes), choose “Plain
Text” as the file type (lower left corner) instead of “Source.”
— To stop a page from loading, click on the Stop button.
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WORLD WIDE WEB: An Internet
protocol (HyperText Transfer Protocol--HTTP) that retrieves and
displays Web pages.
WEB PAGE: An HTML document
that can incorporate text, graphics, sound and motion video clips
with hypertext links to other Web
pages.
HOME PAGE: The starting page
of a Web site with links to other
related pages.
HYPERTEXT: Text that contains
links to other text in documents
which enables you to skip around
and read the document pages in
the order you choose.
HTML (Hypertext markup language): The coding system used
in Web pages that consists of text
and tags that tell the Web browser
what to do when a link is activated.
LINK: A button or highlighted bit
of text that, when selected, jumps
you to another Web page.
WEB SERVER: An application
program that stores Web pages
and its associated files, databases
and scripts. It serves up Web
pages to Web browsers.
WEB BROWSER: Client software
for the Web (such as Netscape)
that displays HTML and other
documents and allows you to follow hypertext links.
URL (Universal Resource Locator): A Web address which consists of a protocol, a host name, a
port (optional), a directory (optional, and a file name (optional).

Just the Facts . . .

Reminder 2
Use URLs to Connect to Web Sites.
1. If you know the URL for a particular Web site, you can go directly to it by:
— Clicking on the File menu, choosing “New Location,” typing in the URL and clicking on the OK button.
OR
— Highlighting the current URL in the Location window, typing in the new URL, and pressing <Enter>.

Reminder 3
Use Net Search to do a Subject Search
1. To search the Web for particular Web sites by subject, click on
the Net Search button.
2. You will see several options for Search Engines with a bar window. Type in your keyword(s) and click on the Search button.
Most search engines list 10 hits at a time.
3. Click on the link to go to the Web page.

READING URLs: A Web address
consists of a protocol, a host name,
a port (optional), a directory (optional, and a file name (optional).
The four basic PROTOCOLS used
in this class are:
http://
(web site)
ftp://
(ftp site)
telnet:// (telnet site)
gopher:// (gopher site)
The HOST NAME is the Internet address:
www.usc.edu
usc.edu
gopher.usc.edu
uscinfo-net.edu

(web)
(ftp)
(gopher)
(telnet)

The PORT NUMBER, if listed, occurs after and is separated from the
Internet address by a colon (:)
gopher://wiretap.spies.com: 70

Reminder 4
Use Netscape for FTP, Telnet and Gopher

The DIRECTORY NAME(s), if listed,
is next, preceded by a forward slash:
http://www.iisd.ca/linkages

1. If you know the URL for a particular FTP, Telnet or Gopher
site, you can go directly to it by:
— Clicking on the File menu, choosing “New Location,” typing in the URL and clicking on the OK button.
OR
— Highlighting the current URL in the Location window, typing in the new URL, and pressing <Enter>.
2. If a Web page has a link to an FTP, Telnet or Gopher site, click
on the link. Once you are connected, these protocols work as
they normally do (i.e., Gopher sites will have menus, FTP sites
will have directories and files to transfer, and telnet sites will
allow you to use the resources of that computer).
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The FILE NAME, if listed, is next,
preceded by a forward slash:
http://www.iisd.ca/linkages/
wssd.html
Use the entire URL when typing in
a location in Netscape.
SEARCH ENGINE: Search engines

search titles or headers of documents, others search the documents themselves, and still others search other indexes or directories.

S ending Polnet Email
—
—
—
—

<

Sending Email to Country Teams

Just the Facts . . .

This section is a reminder for how to:

CONTROL-H (^h): This is the ONLY
way to delete typos in Polnet!

Create an ASCII text file with Wordperfect.
FTP a file to Artemis.
Telnet to Artemis.
Insert the FTP’d file into a Polnet email message.

ARTEMIS is the name of the computer at the University of Maryland
that runs the Polnet II simulation
software.

You will need the ICONS disk for Outgoing Messages.

Reminder 1
Create an ASCII Text File with Wordperfect.
1. In the Wordperfect group, double-click on the WPwin icon.
2. Type your message. Do not add formatting commands (i.e.,
fonts, underlining, bold face, etc.).
3. Make sure your ICONS floppy disk is in Drive A. Click on the
File menu and choose “Save.”
4. Set the configurations for ASCII text and floppy drive A.
Destination drive = a:
File type = ASCII Text
Name = name file in DOS file name format
Do steps 2-3 for each message file you want to create.
5. When you are done, click on the File menu and choose “Exit” to
quit Wordperfect.

Reminder 2
FTP a File to Artemis
1. Make sure your floppy disk is still in drive A.
2. Double-click on the WS-FTP icon in the Network Information
Tools group. You will see the “Session Profile” window.
3. Click on the “New” button.
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POLNET II is the software that runs
the ICONS simulation. It has both
email and on-line, real-time
conferencing capabilities. All of the
negotiating between countries is
conducted via Polnet.
ASCII (American Standard Code for
Information Exchange), pronounced
as-kee, is a numeric encoding of text
characters. For your purposes, think
of it as generic text without formatting. When you save a file in
Wordperfect for instance, program
codes are embedded in the file that
make it uniquely a Wordperfect file.
Saving a file as an ASCII text file
strips away all the program coding
and leaves plain text.
ASCII files are important because
many programs cannot read other
program’s files, but almost all programs can read an ASCII file. For
example, you cannot insert a
Wordperfect file into a Polnet II
email message--Polnet II does not
know how to read Wordperfect
codes. You will see garbled characters on the screen instead of your
message.
DOS FILE NAMES must not exceed
8 characters! Names cannot contain
spaces or any of the following characters: * ? / \ | . , : ; + = { } [ ] & ^ <
> You can add a file extension to
file name by adding a period ( . ) and
three more characters (e.g.,
NAFTA.txt).

Just the Facts . . .

4. Fill in the following information:
Host name: artemis.umd.edu
Host type:
(leave on auto)
UserID:
icons103
Password:
*******
Account:
usa
5. Click on the “save” button.
6. Click on the “profile name” arrow. Click on “artemis.umd.edu”
from the text list. Click on the “OK” button to the right.
7. You will see the transfer screen with two windows: local system
(left) and remote (right).
8. In the “local system” window, change to the floppy drive A.
Your file(s) should be in the lower window of “local system.”
9. Click on the “ASCII” radio button below the “local system” window.
10. Click on the file name in the “local system” window that you
want to transfer to Artemis. (To highlight more than one file for
transfer, hold down the <Shift> key and click on each file name.)
11. Click on the arrow pointing to the right of the two boxed arrows
in between the “local system” and the “remote” windows.
12. When the transfer is complete, click on the “refresh” button at
the bottom right of the “remote” window to confirm that your
files have been transferred to Artemis.
13. When you are done transferring files, click on the “close” button
(far left, bottom of screen). Click on the “exit” button (far right,
bottom of the screen).

POLNET HELP will give you a listing of all commands available to you.
Commands vary in the regular community and conferences; use “help”
to determine which commands are
available to you in either mode.
By entering “help” and a command,
you will get detailed information on
that command. For example, “help
aside” will give you information on
the “aside” command--its syntax,
function, and how it works.
WHAT IS THE DIFFERENCE
BETWEEN TELNET AND FTP?

Reminder 3
Telnet to Artemis
1. In the Network Information Tools group, double-click on the
“Host Presenter-Telnet” icon.
2. In the Host box (top) type: artemis.umd.edu
3. When connected to Artemis, login to Polnet:
Login:
Password:
Community:
Username:
Password:

WHY FTP FILES TO POLNET?
When you login to a computer system, you are using its resources and
adding to the slow response time
of the system. Each semester there
are several ICONS simulations using the Polnet system and, as a courtesy, we like to reduce the amount
of time we are using the system.
Therefore, if you compose your
message with a wordprocessor, save
it as an ASCII file, FTP it to Artemis
and insert it into a Polnet email message, you bascially “get in and get
out” of the system quickly--even if
you are sending several messages
at once.

icons103
*******
cal96hs
usa
******* (yes, password twice)
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FTP is a protocol that transfers file
from one computer to another.
Telnet is a protocol that enables you
to connect to another computer and
use it as if you were sitting there.
You use FTP to transfer files to
Artemis. You use Telnet to connect
to Artemis to use the Polnet program, which allows you to send and
read email and to join the on-line
conferences.

Just the Facts . . .

Reminder 4
Insert FTP’d File into Polnet Email Message
1. To send Polnet email, at the Polnet prompt, type: send.
2. At the “Enter Recipient” prompt, type:
— A question mark (?) for a list of country names.
— all (to send the message to all countries).
— one country name (to send a message to that country).
and then <Enter>.
3. You will get another recipient prompt.
— If you want to send the email message to more than one
country, type in the next country name.
— If you are done listing the recipients, press <Enter> at a
blank recipient prompt.
4. The next prompt you get is “Enter Keyword.” Use this to enter
the topic or issue area of the message (this is important if you or
other countries will be searching for messages by keyword).
5. To insert your FTP’d file into the mail message, type: .i (dot i).
— You will see: Enter Message Filename (.c to cancel).
— Type in FTP’d file name.
— You will see your message text scroll across the screen.
— You will see: O.K. to add file contents to message? (y/n):
— Type: y (for yes).
— You will see: Contents added. Continue entering message.
6. To send the mail, press the <Enter> key to get a blank line and
type: . <Enter> -- (dot + <Enter>).
7. Do numbers 1-6 above for each FTP’d file you want to insert
into a mail message.
8. When you are done, exit Polnet. At the Polnet prompt, type:
exit. You will be returned to the “Host Presenter” window. Click
on the “cancel” button.
9. Choose the File Menu and “Exit” to end your Host Presenter
session.
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SENDING POLNET EMAIL
SEND allows you to sent messages
to other users on Polnet II.
ENTER RECIPIENT: By entering a
question mark (?) at this prompt,
you will get a full listing of all possible recipients in that community.
You can only enter the name of one
recipient on each line. If you are
sending the message to multiple recipients, enter a carriage return to
get another Enter recipient prompt.
If you respond with “all”, POLNET
II will automatically send that message to all members of the community.
When you have finished entering
the list of recipients, enter a carriage return.
KEYWORDS: Words that categorize or describe your message. For
example, keywords in a simulation
might be “arms” (categorizing those
messages dealing with arms control), or Message #. Keywords become important in the search and
retrieval capabilities of POLNET II.
CANCEL: If you wish to cancel the
message, enter .q on a new line.
POLNET II will respond: Message
NOT Sent.
SEND C: Sends a carbon copy of
a message to another user.
SEND F: Forwards a message to
a user that you have either sent or
received to another user.
SEND I: Links the current message
with a previous message.

R etrieving Polnet Email

Just the Facts . . .

Pulling Your Daily
Polnet Email Messages

READING POLNET EMAIL

This section is a reminder for how to:
—
—
—
—
—

<

Telnet to Artemis.
Convert Polnet email messages into files.
FTP the files from Artemis to the Lab PC.
Delete the FTP’s files from Polnet.
Print Email messages with Notepad.
You will need the ICONS disk for Incoming Messages.

Reminder 1

READ allows you to read your new
and previous messages to other users on Polnet II.
PREVIOUS MESSAGES: If you do
not have new messages or after you
read your new messages, you will
be asked if you want to read previous messages. You can search for
messages by the following keys:

Telnet to Artemis

Msg Number: Enter the number or
numbers that you want to read.

1. In the Network Information Tools group, double-click on the
“Host Presenter-Telnet” icon.

Recipients: Enter who received the
message.

2. In the Host box (top) type: artemis.umd.edu

Sender: Enter who sent the message.

3. When connected to Artemis, login to Polnet:
Login:
Password:
Community:
Username:
Password:

icons103
*******
cal96hs
usa
******* (yes, type your password twice)

Reminder 2
Convert Polnet Email Mesages into Files
1. At the Polnet prompt, type: read.
You will be asked if you want to read new messages.
2. To read new messages, type: y.
3. At the end of each mail message, you will be asked:
Do you want to reread, continue, save, quit? r/c/s/q
4.

Date/Time Range: Enter the date
the message was received.
Keywords: Enter the keyword the
message was sent under.
NEW MESSAGES: If you have new
messages when you login to Polnet
II, you will see: # new messages.
When you type the “read” command, the system will tell you how
many messages you have waiting
and the number of lines of each
message.
REREAD (r): Scrolls through the
same message again.
CONTINUE (c): Instructs the computer to go on to the next message.

Choose “s” for save.

5. You will be asked to name the file. Name each message by its
number (i.e., mess001, mess079, mess180), using DOS file name
format. Do this for each new message.
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QUIT (q): Allows you to stop reading your messages before you have
read all of the messages.

6. When you are done converting the messages to files, exit Polnet.
At the Polnet prompt, type: exit.

Just the Facts . . .
READING POLNET EMAIL

7. You will be returned to the “Host Presenter” window. Click on
the “cancel” button.
8. Choose the File Menu and “Exit” to end your Host Presenter
session.

Reminder 2
FTP the Files from Artemis to the Lab PC
1. Double-click on WS-FTP icon in the Network Information Tools
group.
2. In the “Session Profile” window, click on the “New” button.
3. Fill in the following information:
Host name:
Host type:
UserID:
Password:
Account:

artemis.umd.edu
(leave on auto)
icons103
*****
usa

4. Click on the “save” button.
5. Click on the “profile name” arrow. Click on “artemis.umd.edu”
from the text list. Click on the “OK” button to the right.
6. You will see the transfer screen with two windows: local system
(left) and remote (right). You should see connection information
in the lower left corner of the screen.
7. Click on the radio button marked “ASCII” below the “local system” window.
8. Change the drive on the “local system” to A.
9. Click on the file name in the “remote” window that you want to
transfer to the lab computer (to highlight more than one file name,
hold down the <Shift> key and click on each file name).
10. Click on the arrow pointing to the left, located in between the
“local system” and the “remote” windows.
11. When the transfer is complete, click on the “refresh” button at
the bottom right of the “local system” window. You should see
your file names appear in the lower “remote” window.
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WHY THIS PROCEDURE? The
reason why we use this procedure
to pull messages, and only pull messages once a day, is because as
soon as a message is read as a new
message, it becomes an old message. Therefore, if each U.S. team
member logs in each day to read
Polnet messages, the logins after
the first one will not show an accurate listing of new messages.
MESSAGE NUMBERING: Messages sent to individual countries
are not available for other countries
to read. Each country is only allowed to read email sent to it (either individually or in the “all”
receipient mode). Therefore, the
numbered sequence of email message will not be consecutive for the
U.S. team. This does not mean you
have missed messages, it means
that they were directed to other
countries or to SimCon.
NOT MISSING MESSAGES: If
you are not careful about giving
commands while you are converting messages to files for later FTP,
you can sometimes miss a message. You will have to wait until
you have converted all of the new
messages to go back and find it.
Try to write down the message
number that you missed.
After converting the new messages, at the Enter Command
prompt, type: read and the message number. You should see the
message on the screen; proceed
with the conversion to file format.

Just the Facts . . .

Reminder 4
Delete the FTP’d Files from Artemis
1. To delete the FTP’d files from Artemis, in the “remote” window,
click on the name(s) of the file(s) you have just FTP’d and then
click on the delete button on the right side of the “remote” window.
2. Close the FTP connection to Artemis by clicking on the “close”
button (far left, bottom of screen), but do not exit WS-FTP.

Reminder 5
Print Email Messages with Notepad
1. In the “local” window, click on the first FTP’d file name. Click
on the “view” button, top right on “local” button panel. You
should see the Email message text. You are now in the Windows Notebook program (an ASCII text editor).
2. Click on the File Menu, then “print.” You will see a message
indicating that it is being sent to the network print spooler.
3. When the print spooler message is gone, close the file by clicking on File Menu and “Exit.”
4. Repeat the above three steps to print all the pulled messages.
5. When you are done printing, exit WS-FTP by clicking on the
“exit” button (far right, bottom of screen).

UNIX ACCOUNT SECURITY: You are responsible for your Unix account. Do not let anyone else use your Unix account and do not give
anyone your password (no official USC staff or faculty member will require your Unix password for any reason). If you allow someone else to
use your account and misuse it (breach USC Computing Policies or U.S.
Federal or State laws), you will be held responsible.
LOGOUT FOR SAFETY: Do not leave your Unix account running on
a computer workstation in a public lab. Always logout, even if you will
only be gone a moment.
CHANGING YOUR PASSWORD: Change your Unix password periodically. At the Unix prompt, type: passwd.
The system will prompt you for your old password and then your new
password. You new password will not take effect for 1-2 hours.
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WINDOWS NOTEPAD is a text
editor that you can use to edit or
print small text files.
PRINTING MESSAGES: While
you are still in WS-FTP, you can
print the Polnet messages you
have just transfered. When you
click on the file name and then
click on the Print button, WS-FTP
opens the file in Windows
Notepad and prints it from there.
After each file has been printed,
you need to exit Notepad to return to WS-FTP to chose the next
file to print.
SOME NOTEPAD COMMANDS:
Open: Opens a text file.
The file can be a Notepad file or
any file saved as text-only from another application. Notepad cannot
open a file larger than approximately 50K.
Save: Saves changes to the document you have been working on.
Save As: Saves a new or existing
document. You can name a new
document or save an existing
document under a new name. The
original document remains unchanged.
Print: Prints one copy of the document.
Exit: Closes the document you
have been working on and quits
Notepad. You can save the file
before quitting.

D istributing Polnet Email
DistributingYour DailyPolnet
Email Messages to the U.S. Team
This section is a reminder for how to:
— Upload (FTP) daily message files to your Unix account.
— Use Pine’s Address Book for distribution list mailing
— Insert daily message files into a Pine email message

<

You will need the ICONS floppy disk for Daily Messages.

Reminder 1
Upload Daily Message Files to Your Unix Account
1. In the Network Information Tools group, double-click on the
WS-FTP icon.
2. In the “Session Profile” window, click on the “new” button.
3. Type in the following information:
Host name:
Host type:
UserID:
Password:

Choose one of the SCF hosts
(leave on auto)
Your Unix account UserID
Your Unix account password

Just the Facts . . .
UNIX ACCOUNT STORAGE
SPACE: Since you will be sending large email files of daily Polnet
messages to the U.S. team members everyday, you will need to
be careful about managing your
Unix account.
The best management system is
to export the daily Polnet email
messages to your Unix directory
and FTP them to a floppy.
UNIX ACCOUNT QUOTAS
All Unix accounts are subject to
a disk space quota. For instance
if your quota is 10 megabyes, as
on the SCF, you will receive a
warning message if you use over
10 magabytes (called the “soft
limit”) of storage and will be unable to write more files if you use
over 11 megabytes (called the
“hard limit”).

4. Click on the “save” button.
5. Click on the “Profile Name” arrow. Click on girtab.usc.edu (or
whatever you entered above).
6. Click on the “OK” button to the right.
7. You will see the transfer screen with two windows: local system
(left) and remote (right). You should see connection information in the lower left corner of the screen.
8. Click on the radio button marked “ASCII” below the “local system” window.
9. Change the drive on the “local” system to a:. You should see the
list of files located on the floppy disk in the “local” window.
You should see files located on your Unix account directory in
the “remote” window.
10. Click on the file name in the “local” window that you want to
transfer to your Unix account directory (to highlight more than
one file name, hold down the <Shift> key and click on each file
name).
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If you receive a warning message
that you are over quota, that
means you have used up more
than the soft limit of disk space.
You generally have seven days to
remove enough files to bring
your usage below that level. If
you do not, you will be not be
able to create and save new files,
or save changes to your files (this
includes receiving new email
messages).
To display your disk quota and usage, type quota -v at the Unix
prompt.
Source: The Primer, pp. 89-90.

11. Click on the arrow pointing to the right, located in between the
“local” and “remote” system windows.
12. When the transfer is complete, click on the “refresh” button on
the “remote” system window to verify that all the files transferred.
13. Close the FTP connection to Unix by clicking on the “close”
button (far left, bottom of screen). Exit WS-FTP by clicking on
the “exit” button (far right, bottom of screen).

Reminder 2
Use Pine’s Address Book for Distribution List Mailing
1. In the Network Information Tools group, double-click on the
“Host Presenter-Telnet” icon to access your Unix account.
2. In the “Host” box (top), type: SCF host. Login to your Unix
account. At the Unix prompt, type: pine.
3. At the Pine Main Menu, choose “A” for Address Book. Highlight the ICONS distribution list for the U.S. Team.
4. Press “C” to compose a message to the distribution list names.
5. In the “Subject” part of the header, indicate the sequence of
message numbers you will be sending and the date messages
were pulled.
6. Move the cursor down to the body of the message.

Reminder 3
Insert Daily Message Files into a Pine Email Message
1. To insert a message file into the email message, type: ^R (control key + R). To see a list of available files, type: ^T.
2. Highlight the first file to insert and type: s (select). You will see
the selected file scroll across the screen in the email message.
3. Press the <Enter> key a few times to separate the messages, and
repeat the above two steps for all files to be inserted.

Just the Facts . . .
INFORMATION MANAGEMENT:
One of the most important skills
you will have to apply in this class
is information management. Before the simulation begins, you will
have to do a great deal of research
on your subject area to be prepared for the simulation. Be careful to narrow your focus enough
to obtain the pertinent information
you require--it is easy to get
bogged down and overloaded by
too much data. Develop a system
to categorize and store your data
so you can access it quickly during an on-line conference.
Once the simulation begins, you
will be receiving daily messages
from the other country teams via
Polnet. The distribution and organization of these messages is
crucial. Messages are saved on a
floppy (for backup), printed out for
the binder (to review during a conference) and sent to each member of the U.S. Team (up-to-date
information keep you on top of the
issues and gives you a head start
on necessary additional research).
Work with your team mates to formulate organizational strategies
for all of this incoming information.
Each team member should have a
day to pull and distribute messages.
Hold each other accountable for
the required duties.

4. When all files are inserted, send the file (^X).
5. To end your Pine session, type: q. Logout of your Unix account
(at the Unix prompt, type: logout).
6. To close your Host Presenter session, click on the “close” button. Click on the File Menu and the Exit.
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Make each member carry his/her
share of responsibilities. If you
cover another team member's responsibility, make sure they return
the favor.

O n-line Conferences
Just the Facts . . .

Polnet On-Line Conferences
This section is a reminder for how to:
— Telnet to Artemis
— Enter the on-line conference
— Print incoming conference messages
— Send outgoing conference messages

WHO: Gives you a listing of other
users currently logged in to the
community.
Using “who” within a conference
will give you a listing of conference
members currently logged in to the
conference.

Reminder 1
Telnet to Artemis
1. In the Network Information Tools group, double-click on the
“Host Presenter” icon.
2. In the Host box (top), to Telnet to Artemis, type artemis.umd.edu
3. When connected to Artemis, login to Polnet:
Login:
Password:
Community:
Username:
Password:

CONFER: The Polnet command
that allows you to enter on-line
conferences.

icons103
*******
cal96hs
usa
******* (yes, password twice)

Reminder 2
Enter the On-Line Conference
1. At the Polnet prompt, type: confer.
2. At the “Enter Conference” prompt, type: the name of the conference. If you do not know the name of the conference, type a
question mark (?) for a list of conferences. You may only attend
a conference of which you are member.
3. When you are asked if you want to bypass additional questions
(y/n)? Type “y” for yes. (In conference mode, you want continuous flow of messages from the other countries and answering yes will do this.)
4. The system will response with: Entering Conference . . .
5. Before doing anything else, activate the print capture. From
the Host Presenter File Menu, choose “print.” You will see four
options for printing. Click on the radio button for “Continuous Print.”
Click on the “OK” button.
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Using “Who c” gives you a listing
of conferences currently in session.
ASIDE: Allows you to send a nonrecorded message. Once this
message has been read, it cannot
be accessed again by either the
sender or recipient.
“Aside” is generally used within the
regular community to send procedural messages. Within conferences, "aside" is a frequent
method of communication and is
used to send secret, sensitive messages to other users.
After using "aside" in a conference, POLNET II will leave you at
enter command:. Use the "listen"
command to get back into listening mode.
TELL SIMCON: At each conference, after you login and set the
print capture, send an “aside” message to SIMCON to let her know
which members of the U.S. Team
are at the conference (so you get
credit for being there).

Reminder 3
Print Incoming Conference Messages
1. If other participants have already sent out messages when you
arrive, the following will appear:
xx New Messages (xx = number of new messages).
Read most recent messages (y/n)?
2. Type “y” for yes.
3. The system will respond with:
Enter number of messags to be read:
4. Enter the same number as the number of new messages received,
all of the messages sent will scroll across the screen.
5. After the most recent messages have scrolled across your screen,
and when there are no more new messages to be read, the following will appear:
Listening . . . Press return to enter commands.
You are now in listening mode. As other conferees send messages, they will appear on your screen automatically.
6. At this point, send the captured messages to the printer to clear
the buffer and reset the continuous print for the next batch of
scrolled messages.
Click on the File Menu and choose “Continuous Print Off.”
You will see a messages from the print spooler. When the
message is gone, immediately reset the continuous print (or
you may miss incoming messages). Click on the File Menu
and then click on the radio button for “continuous print.”
7. As the new messages arrive and scroll across your screen, wait
for a pause in the flow and repeat the above two steps to send
the captured messages to the printer.

Reminder 4
Send Outgoing Conference Messages
1. When you want to send messages to the other country participants, press the <Enter> key to get a command prompt.
2. To send a message to the entire conference, type: comment.
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Just the Facts . . .
CORRECTING TYPOS
When you make typos during a
conference message, DO NOT use
the ^h to backspace over the typo.
If the word is recognizable, leave it
and continue. If it is not, use the
<space> bar to put in a few spaces
and then retype the word.
For some reason, the U.S. Team’s
messages get very garbled if we
don’t follow the above procedure.
ON-LINE CONFERENCES: Unlike
Unix talk, BBS chat or IRC forms
of on-line, real-time communication
(where you type on the screen and
you see the response on the screen-often both at the same time),
Polnet on-line conferences are conducted via email messages.
When you are in the conference
mode, you type a message using
the same format at a regular email
message, except that it is sent to
the conference participants instead
of regular email mailboxes.
CONTINUOUS PRINT: Be diligent
to maintain the continuous print
feature of Host Presenter-Telnet.
While you are composing a message, other messages are building
up on the system. When you finally send the message and view
the next batch of incoming messages, they all scroll past you on
the screen without a pause between messages. There is NO
TIME to go back and read messages on the screen. You and your
fellow team members at that conference must have a printed copy
from which to read and work!

3. If you want to send a private message to one or more specific
conference members, but not to the entire group, type: aside at
the command prompt. The computer will prompt you with:
Enter Recipient:
Enter each recipient separately and then hit an extra <Enter>
after the last recipient.
4. Type your message, remembering to press the <Enter> key when
the cursor gets near the right side of the screen. (Keep in mind
that this is not a wordprocessor; you cannot edit a line after you
have hit the <Enter> key and have moved to the next line.)
If you decide to cancel your messages, go to a new line and type:
.q (period + q).
5. After you type your messge, go to a new line and type a period
( . ) and <Enter> to send your message.
6. At the command prompt, return to the conference by typing:
listen. Any new messages send will scroll across your screen.
At the pause, send the captured messages to the printer.
Click on the File Menu and choose “Continuous Print Off.”
You will see a messages from the print spooler. When the
message is gone, immediately reset the continuous print (or
you may miss incoming messages). Click on the File Menu
and then click on the radio button for “continuous print.”
7. Continue sending and receiving/printing messages for the duration of the conference. If, at any time, you need to leave the
conference, but not the simulation, type: leave at the command
prompt.
8. When the conference is concluded, to exit the simulation, type:
exit.
9. Send the final captured messages to the printer.
10. Close your Host Presenter session by clicking on the “close”
button. Click on the File Menu and then Exit.
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Just the Facts . . .
CORRECTING TYPOS
When you make typos during a
conference message, DO NOT use
the ^h to backspace over the typo.
If the word is recognizable, leave
it and continue. If it is not, use the
<space> bar to put in a few spaces
and then retype the word.
For some reason, the U.S. Team’s
messages get very garbled if we
don’t follow the above procedure.
MISC POLNET COMMANDS
DIR (short for directory): produces
a directory of messages addressed
to or sent by you. A directory listing includes the message number,
sender, date it was sent, length of
message, and the keyword the
message was tagged with.
"Dir" asks you to specify a number of parameters. A parameter
can be skipped by entering a carriage return. These parameters,
and some possible:
Enter recipient:
Enter sender:
Enter date/time range:
Enter keywords:
Enter message number:
If you leave all the parameters
blank, you will get a listing of all
the messages that you received
since the community became operative, as well as a listing of all the
messages that you have sent.

